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SnagIt is the print utility that Windows forgot.  SnagIt is a screen print and capture program for 
Windows.  SnagIt processes input from the screen, the clipboard, or a BMP file and outputs to 
the default printer, the clipboard, or a BMP file.  SnagIt provides control over color intensity, 
monochrome intensity threshold, and gray scaling.  SnagIt may be controlled by DDE to provide 
other applications the ability to output screen data.
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HTI Overview

Horizon Technologies Inc. (HTI) is a computer consulting and software development company 
located in Okemos, Michigan.  We provide a full range of services to organizations assessing or 
implementing Windows or OS/2 applications for use in distributed systems.  We concentrate our 
services on those areas that are most likely to complement the capabilities within our customer's 
organizations.  We offer assistance during the assessment and design and development phases.  
We offer an extensive background in the successful implementation of distributed applications on
Windows and OS/2 platforms.  Our experience includes projects using all major network 
topologies, protocols, LAN operating systems, and many LAN-based commercial products.

Copyright Horizon Technologies Inc. 1990, 1991
All Rights Reserved.
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Introduction

This Manual is divided into several sections.  The first section contains 
installation instructions and directions on how to create basic screen 
prints with SnagIt.  The second section is the feature reference.  The 
feature reference will explain each of the SnagIt menu items and it 
effects.  The Last section is Advanced Topics.  It contains discussions 
of how to make use of the advanced features of SnagIt such as, gray 
scaling and using Dynamic Data Exchange

This document was created using SnagIt and Microsoft Word for Windows
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Installation

System Requirements:

        - Windows 3.0 
        - A printer that supports Bitmaps such as an HP Laserjet or Postscript Printer

Installing SnagIt is easy.  Simply copy the file SNAGIT.EXE to your 
windows directory.

Example:

COPY A:SNAGIT.EXE C:\WINDOWS

Next start Windows and create a new program item with the Program 
Manager.  If you need help with this, consult your Windows Users 
Manual.  We recommend placing SnagIt in the Accessories Group.

To have Windows load SnagIt automatically, edit your WIN.INI file in the
WINDOWS directory and add SNAGIT to the load line. 

Example:

Load=CLOCK SNAGIT

This will load the clock and SnagIt as icons.
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Getting Started

Printing a Screen

In this section you will learn how to use some of the basic features of SnagIt and how to create 
your first screen print

Loading SnagIt

If you chose to have SnagIt load automatically during the install procedure, you should see the 
SnagIt icon displayed after you start windows .    If SnagIt has not been automatically loaded for 
you, double click on the SnagIt icon in the Accessories Group

Selecting The Print Area

SnagIt can print the entire screen, a selected region of the screen or a single window..  To select 
what to print, double click on the SnagIt icon to restore SnagIt to a window.  The SnagIt 
windows will display the current settings.  Click on the Input menu item to view the list of 
options. Select one of the following options:

Screen:
Prints the entire screen.

Entire Window:
Prints a single window.

Client Area:
Prints only the window client area

Region:
Allows you to select a rectangular region anywhere on the screen.

If you selected Entire Window,Window Client Area or Region SnagIt will allow you to select the
window or region when you print.
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Printing

To print press [Ctrl][Shift]P.  

If you have selected Entire Window or Window Client Area as the input area, position the 
pointer on the title bar of the window you wish to print and press the left mouse button.

If you selected Region as the input area position the pointer at the upper left corner of the region 
you wish to print.  Hold down the left mouse button and drag the pointer to the lower right 
corner of the region and release the mouse button.

Clicking the right mouse button will cancel the operation

While SnagIt is printing the following message box will be displayed.

 

To cancel a screen print click on the Cancel button in the message box
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Feature Reference

Mouse Controls

Left Button - The left mouse button is used to select SnagIt menu options and to select 
the screen image.

Right Button - The right mouse button is used to cancel an operation

Input

The Input Menu is used to select what SnagIt will print.  The currently selected option is marked 
by a check mark.  The different input options work as follows:

Screen - When you select screen, SnagIt will print the entire screen.

Window Client Area - If you select this option SnagIt will print only the client area of a 
single window.  The client area is the area surrounded by the window borders.  The client
area does not include the borders, title bar, scroll bars or the caption line.  After you press
[Ctrl][Shift]P, select the client are you want to print by positioning pointer anywhere in 
the client area and click the left mouse button.

Entire Window - Selecting this option causes the entire window to be printed.  After you 
press [Ctrl][Shift]P position the pointer over the window you want to print and click the 
left mouse button.  Note: windows can contain many smaller windows inside of them.  
Items such as OK and Cancel buttons, and icons are windows themselves.  Clicking on 
one of these will result in only the button or icon printing.  It is best to click on the title 
bar of the window you want to print.

Rectangular Region -  Press [Ctrl][Shift]P then select the region to be printed by 
positioning the pointer over the upper left corner of the region.  Press and hold the left 
mouse button then drag the pointer to the lower right hand corner of the region and 
release the mouse button.

Bitmap File -  If you select this option SnagIt will display a dialog box requesting the 
name of the file to read the bitmap from.  Bitmap files are graphics files generated by 
some paint programs, SnagIt or other Windows programs.  Bitmap files usually have a 
file extension of .BMP. 

Clipboard - Selecting the clipboard option causes SnagIt to print the contents of the 
Windows clipboard when you press [Ctrl][Shift]P.  Items are placed on the clipboard by 
the cut or copy commands in other Windows programs.  
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Output

The Output Menu allows you to select where SnagIt will print to.  SnagIt Supports the following 
output devices:

Printer - When printer is selected sends the output to the currently selected Windows 
printer.

Bitmap File - If bitmap file is selected SnagIt will ask you for the name of the file to 
print the bitmap to.

Clipboard - Selecting the clipboard option causes SnagIt to send the input image to the 
Windows Clipboard

Using SnagIt to print images to a bitmap file, or the clipboard can be very useful for importing 
screen images  into a word processor, desktop publishing package or a paint program.

Format

SnagIt supports three different format options, monochrome, color, and gray scale.  Select the 
format option you want with the Format Menu.  The current option will be marked with a check 
mark.  The format options work as follows:

Monochrome - The input image is converted to monochrome before it is set to the output
device.  The monochrome threshold determines the amount of black and white in the 
output image.

 
Monochrome Threshold Dialog Box

Color - Color boosting, if enabled, is applied to the input image before it  is sent to the 
output device.

Gray Scale - Colors are mapped to up to 256 shades of gray before the image is sent to 
the output device. 

See the Advanced Topics for further discussion on formatting options.

Options
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Alert - Setting the alert options causes SnagIt to signal you with a when it has completed 
processing the input image and/or when it has completed sending the image to the printer or 
other output device.  The value entered for this field determines the number of beeps.  This is a 
particularly useful feature when using the gray scale option.

Clipboard Chain - Setting the clipboard chain option to true causes SnagIt to print each time the 
clipboard changes.  This is useful for doing a print screen from a DOS box.  When you press the 
Print Scrn key in a DOS box Windows copies the screen to the clipboard.  If you have the 
clipboard chain option set, SnagIt will then automatically copy the image to the printer for you.

Note: The input device must be set to clipboard for clipboard chaining to work.

Color Boost - This option is used to set the amount of color boost for Red, Green, and Blue.  For 
each color range you can enter a value between -255 and +255, and/or use the slider bar to set the
boost level.  The default value for each range is zero.  See Advanced Topics for a discussion on 
color boost.

 
Color Boost Dialog Box

Scaling - The scaling option determines the size of the output image.  There are three scaling 
options:

Best Fit - This option scales the input image to best fit a page for the output device (ie; an
8.5 by 11 sheet of paper)

Screen - Selecting screen causes the output image to be printed the same as it appears on 
the screen.

User - The user option allows you to enter an integer scaling multiplier to be applied to 
the output image.  A multiplier of 2 will double the size of the input image.

Note: scaling works only for gray scale and output to the printer

Save Setup

The save setup option is located under the system menu (Alt Space).  When you save the setup, 
SnagIt will write all of the current settings to your WIN.INI file.  SnagIt will read the saved 
setup each time it is loaded
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Advanced Topics

Monochrome Conversion

When Windows converts a color image to monochrome, it converts anything that is the 
background color, or white to white.  All other colors are converted to black.  This usually results
in a lot of the image converted to black.  SnagIt uses a monochrome threshold when converting a
color image to monochrome.  SnagIt looks the intensity level of each pixel and converts higher 
intensities (lighter colors) to white and the lower intensities to (darker colors) black.  This 
conversion process will usually result in a more even balance of black and white in the output 
image.  The amounts of black and white can be controlled by adjusting the Monochrome 
Threshold value under the Monochrome setting of the Format Menu.  Adjusting the color boost 
values can be used to adjust color intensities before conversion to monochrome.

You may get much better results converting images to monochrome if you use the windows setup
program to configure Windows for a monochrome monitor.  You may need your Windows 
diskettes the first time you do this (you can easily switch back to color when you need to). In 
monochrome mode Windows will then create grays as a pattern of black and white which will 
print nicely to a monochrome device.  In color mode gray will be converted to all black or all 
white. 

Color Boost

Color boost is used to change the intensity of the colors, changing how the be output image will 
look.  Increasing the boost value lightens the output.  Color boost is performed before gray 
scaling or monochrome conversion, so it can be used to lighten or darken the output with these 
options as well..

Gray Scaling
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Gray scaling can be performed as an alternative to monochrome 
conversion.  SnagIt can represent colors with 256 levels of gray.  The 
shades of gray are determined by the intensity level of the colors.  
Color intensity levels can be adjusted using the Color Boost under the 
Options Menu.   

Caution: Gray scaling can be very slow.  It is a good idea to try a small 
region of the screen before printing the whole screen.  You may also 
want to turn on the Alert feature under the Options Menu.

DDE Usage

SnagIt supports Windows Dynamic Data Exchange (DDE).  You can 
invoke SnagIt from other Windows programs by sending SnagIt DDE 
Messages.  For Example, you can print write an Excel macro that will 
print a portion of the screen using SnagIt.  See Appendix A  for the 
DDE command reference.
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Appendix A  -  DDE Reference

Initiating a DDE Session

To initiate a DDE with SnagIt send a DDE_INITIATE with the application parameter of 
"SnagIt" and the topic parameter of "SnagIt"

Setting SnagIt Options

All of the SnagIt Menu options can be set using the DDE_EXECUTE command.

Example

[set ('string')]

The parameter string can be one of the following:
input screen
input client

input window
input region

input file
input clipboard

scale best
scale screen

scale n 
(where n is an integer > 0)

output printer
output file

output clipboard
chain b     (where b is 1,True,Yes,0,False, or No)

boost red,green,blue
(integer value 0..1000)

add red, green, blue
(integer value -255..255)

inalert n
(where n is the number of beeps)

outalert n

Activating SnagIt

SnagIt is activated by sending a DDE_EXECUTE command with the message:

[snag("string")]
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The string parameter can be one of the following:

snag
(activates menus selected input)

screen
clipboard
filename

x y
(where x,y are coordinates within a window)

client x y
handle h

(where h is a valid window handle)
client handle h

tx ty bx by (where tx,ty,bx,by are coordinates defining a region)
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Appendix B  -  Other HTI Products

Other Software Available from Horizon Technologies, Inc.

DDEWatch

DDEWatch is a Windows DDE monitoring utility. Each message that DDEWatch displays 
consists of decoded bit fields, command/data strings and atom names  DDE also supports file 
logging. allowing DDE conversations to be captured and written to a file. 

DDELib

DDELib offers Windows programmers an API that significantly reduces the effort required to 
write fully functional DDE compliant applications.  Client and server demonstration programs 
are included.  

Table Update

Table update is and end-user Windows front end for the Microsoft SQL Server.  It facilitates data
entry into a set of hierarchically related tables  Table update is dynamically driven by the 
database schema, including primary and foreign keys, so no programming is involved.  Table 
updatefeatures a Basic style macro language, ad-hoc table queries, Dynamic Data Exchange, 
Multiple Document Interface and on-line help facilties.
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The print utility that Windows forgot!  Use SnagIt to print screens, windows, and icons from 
Microsoft Windows.

 

Use SnagIt to capture a window and import it into your favorite Windows word processor or 
desktop publishing program.

Horizon Technologies Inc.
1745 Hamilton Road  Suite 300

Okemos, MI  48864
(517) 347-0800
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